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ÖNSÖZ 

 

Birçok mühendislik probleminin çözümü Akışkanlar Mekaniği temelindeki bilgilere 

dayanmakta ve Sonlu Elemanlar Yöntemi bu alanda da aktif bir şekilde 

kullanılmaktadır. Hazırladığımız bu ilk notların, Ansys-Klasik’in Akışkanlar Mekaniği  

modülü  FLOTRAN’a yeni   başlayanlar için  faydalı olması temennisiyle… 
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1      TEMEL BİLGİLER 

 

1.1 Programa Giriş 

Flotran  programı ANSYS tabanında çalışan bir programdır.FLOTRAN’ı çalıştırmak 

için ; 

-Başlat >Tüm programlar>ANSYS 10.0> ANSYS Product Launcher   kısmına 

tıklayarak programı çalıştırıyoruz.  

-Karşınıza çıkan pencerede  lisans  kısmında  ANSYS Mechanical/FLOTRAN  

kısmını seçiyoruz. 

-Working Directory kısmında  kayıt yapmak istediğiniz alanı Browse  tuşuna 

basarak ayarlayabilirsiniz. 

-Job Name kısmına yaptınız  analiz ismini giriniz . Run tuşuna basarak    Flotran’ı 

başlatıyoruz. 

 
Şekil 1 
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1.2 Program Menüleri 

Aşağıdaki  açılan pencerede kontroller 4 bölümdür. 

     

 
Şekil 2 

     

    1. ANSYS Main menü  

     

    2. ANSYS toolbar 

     

    3. Utility Menü  

 

    4. Pozisyonlama Menüsü 
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1.3 Analiz Adımları 
Ansys ile yapılan analizlerde şu sıra izlenebilir: 

 

a.Preferences:  
b.Preprocessor: 

1. Jobname değiştirme 

2. Element tipi tanımlama 

3. Akışkan tipi tanımlama 

4. Modelleme  

5. Mesh özellikleri belirlenir ve mesh yapılır. 

c.Solution: 
      1.Sınır koşulları belirlenir. 

      2.İterasyon sayısı belirlenir 

      3.Analizin yapıldığı çevre koşullarının belirlenmesi 

      4.Çözülür 

d.Postprocessing: 
      1.İstenilen değerler ve grafikler elde edilir. 

e.Save ve Exit 

a.Preferences 

Yapılacak   analiz tipi seçin.. 

FLOTRAN CFD seçilerek ok tuşuna basıyoruz. 

    
Şekil 3 
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b.Preprocessor: 

       Ön hazırlıkların yapıldığı kısımdır. 

      Jobname değiştirme 

-Yapacağımız uygulama ismini girmek için aşağıda gösterildiği gibi  Utility 

Menü>File>Change Job name kısmına giriyoruz.(Şekil 4) 

 
Şekil 4 

 

   -New jobname kısmına yapacağınız analizin ismini yazın ve OK  tuşuna basın. 

 

     
Şekil 5 
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1.4 Eleman tipi tanımlama 

    Aşağıdaki şekil 6 de gösterildiği gibi ANSYS Main Menü>Preprocessor>element 

type>Add/Edit/Delete  giriyoruz.Çıkan elements types penceresinde  add tuşuna 

tıklayın.Çıkan library of elements types penceresinde FLOTRAN CFD altında 

bulunan elementlerden birini seçerek eleman tipini tanımlayın.Bu elemanı seçerken 

dikkat etmemiz gereken modelleme şeklimize göre element  tipini belirlememiz 

gerektiğidir.(2D veya 3D model).  

 

 

 
Şekil 6 
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1.5 Akışkan tipi tanımlama 

ANSYS Main Menü>Preprocessor>Flotran setup>Fluid properties  kısmına tıklatın 

çıkan pencerede kullandığınız akışkanın özelliklerini belirleyeceğiz.(Şekil 7) 

 

          
Şekil 7 
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     Yukarıda numaralandırılmış akışkan özellikleri şunlardır: 

1 > Akışkan malzemenin yoğunluk özelliğinin belirlenmesi 

2 > Akışkan malzemenin viskozitesinin özelliğinin belirlenmesi 

3 > Akışkan malzemenin iletim katsayısının  özelliğinin belirlenmesi 

4 > Akışkan malzemenin ısınma ısısı özelliğinin belirlenmesi 

Akışkan özelliklerini belirledikten sonra  OK tuşuna basıyoruz .Çıkan yeni pencerede 

özelliklerin sayısal değerlerini giriyoruz.(constant olarak belirlersek) 

 

 
Şekil 8 
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1.6 Malzeme Özellikleri  
ANSYS Main Menü>Preprocessor>Material props>material model kısmına tıklıyoruz 

Materyal gerekli özelliklerini seçiyoruz ve sayısal değerlerini giriyoruz. 

 
Şekil 9 

1.7 Modelleme  

 ANSYS Main Menü>Preprocessor>�odeling bu kısımda modelleme özelliklerini  

kullanarak modellemeyi gerçekleştiriyoruz. 

 
Şekil 10 
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ANSYS toolbar> Save db 

1.8 Elemanlara Ayırma (Meshing)  

   ANSYS Main Menü>Preprocessor>meshing  kısmındaki özellikler kullanılarak akış 

modelinin sonlu elemanlara bölünmesi sağlanır.bölümleme miktarı ne kadar fazla 

olursa gerçek sonuca o kadar yaklaşılır ama işlem süresinde uzar. 

    Bölümleme boyutları ANSYS Main Menü>Preprocessor>meshing > Size cntrl 
Altında yapılır ve çeşitli yöntemleri vardır.  

    Bölümleme işlemi ANSYS Main Menü>Preprocessor>meshing >mesh altında 

yapılır ve isteğe bağlı uygulama şekilleri bulunur. 

 

 
Şekil 11 
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1.9 Sınır Şartları  

ANSYS Main Menü>Solution>Define loads>Apply  kısmı altında sınır koşulları model 

üzerine uygulanır. 

 

 
Şekil 12 
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1.11 İterasyon sayısı belirlenir 

        ANSYS Main Menü>Preprocessor>Flotran set up>Excution  ctrl  e girildiğinde 

çıkan ekranda EXEC Global iteration kısmını gerekli iterasyon sayısı ile değiştirilir. 

 

Şekil 13 
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1.12 Analizin yapıldığı çevre koşullarının belirlenmesi 

ANSYS Main Menü>Preprocessor>Flotran set up>Flow environment  kısmında 

Referans koşulları , yerçekimi ivmesi gibi özellikler bulunmaktadır. 

 

 

1.13 Çözüm 

ANSYS Main Menü>Preprocessor>Flotran set up>Solution options  a tıklayarak 

çözümleme özelliklerini değiştirebiliriz. 
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Şekil 14 

 

1 >stady state(sürekli) veya transient (süreksiz) 

2 >akış denklemlerini çöz (yes/no) 

3>adyabatik/termal 

4>Akış tipi(Reynold sayısına göre) 

Re=ρVD/μ=VD/ν 

Re<2500 laminar akış 

Re>4000 Türbülent akış 

 

5>Sıkıştırılabilir veya sıkıştırılamaz  akışkan kabulü 

 

ANSYS Main Menü>Solution>RUN FLOTRAN(çözümleme) 
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1.14 Sonuçlar  

Bu kısım altın da elde edilen sonuçları görebiliriz. 

ANSYS Main Menü>General postproc>Read results>first set  

ANSYS Main Menü>General postproc>plot results 

1.15 Save ve Exit 

-Utility Menü > exit 

-Save everything seçeneğini seçip her şeyi kaydedin ve programdan çıkın. 

 

 

 
Şekil 15 
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2     2 BOYUTLU   DIŞ AKIŞ PROBLEMİ 

 

2.1 Problem tanımı: Şekilde verilen dairesel profile sahip  16,4 mm çapında boru 

üzerine 18 C ve 6 m/s hız ile hava  veriliyor.Borunun dış sıcaklığı 70 C  olduğuna 

göre                

i) Borunun dış yüzeyinde oluşan hız hatlarını gösteriniz. 

ii)Borunun dış hatları üzerinde oluşan basınç hatlarını gösteriniz. (SI birim sistemi) 

 
Şekil 16 

 

Utility Menü>File>Change jobname  

 

 
 

Şekil 17 
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2.2 Analiz tipini seçilmesi    

Preferences> FLOTRAN CFD >OK 

 

 
 

Şekil 18 

 

 

2.3 Analizde kullanılacak elementin seçilmesi 

ANSYS Main Menü>Preprocessor>element type>Add/Edit/Delete  

Element types >Add 

 

Library of element types >FLOTRAN CFD>2D FLOTRAN 141>OK 
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Şekil 19 

 

2.4 Akışkan özelliklerinin belirlenmesi 

ANSYS Main Menü>Preprocessor>Flotran set up>Fluid properties   
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Şekil 20 

 

2.5 Akışkan özelliklerinin sayısal değerlerinin girilmesi 

 Havanın özellikleri Cp=1007J/kg.K ,viskozitesi:14.82e-6,yoğunluğu:1.217 kg/m^3  

alınmıştır. 

ANSYS Main Menü>Preprocessor>Material Props>Material Models 
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Şekil 21 

 

 
Şekil 22 
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Şekil 23 

 
Şekil 24 

 
Şekil 25 
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2.6 Akış sisteminin modellenmesi 

 

ANSYS Main Menü>Preprocessor>modelling>Create>Areas>Rectangle>By 2 

corners X=0 Y=0 Width=0.1m Height=0.1m girin ve OK  

  
Şekil 26 

ANSYS Main Menü>Preprocessor>modelling>Create>Areas>Circle>Solid circle 

X=0.05m Y=0.05m Radius=0.0082m girin ve OK  
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Şekil 27 

 

Oluşturduğumuz silindir kesitini akış yüzeyinden çıkartmak için 

ANSYS Main Menü>Preprocessor>modelling>Operate>Booleans>Subtract>Areas 

Çıkan ekranda ok diyerek tüm tüzeyi seçiyoruz.Ana kontrolde de ok diyoruz 
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Şekil 28 

Şimdi de atılacak alanı seçiyoruz >OK 

 
Şekil 29 
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Akış modelimizi oluşturduk. 

ANSYS toolbar >save db 

 

 
Şekil 30 

2.7 Mesh  

 

Ayarlarını yapmak için 

ANSYS Main Menü>Preprocessor>Meshing>Size Cntrls>Manual size>Picked lines 

İlk olarak daire kısmındaki çizgileri seçiyoruz >Apply 

Size kısmına 0.001 yazıyoruz >OK 

Aynı işlemi dikdörtgen kenarları için uyguluyoruz ve Size kısmına 0.01 giriyoruz>OK 

Mesh özelliklerini belirlemiş olduk. 
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Şekil 31 



15.02.2008 

Ansys-Flotran’a Giriş 29

 
Şekil 32 

Mesh işlemini gerçekleştirmek için ; 

ANSYS Main Menü>Preprocessor>Meshing>Mesh>Areas>Free 
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Şekil 33 

 

Modeli seçiyoruz >OK 
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Şekil 34 

 

2.8 Sınır koşullarını uygulamak için; 

ANSYS Main Menü>Solution>Define loads>Apply >Thermal>Temperature>on line 

Borunun dış yüzey sıcaklığını uygulamak için  dairesel çizgileri seçiyoruz >Apply  
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Şekil 35 

Çıkan pencerede TEMP seçiyoruz ve sıcaklık değerini  önceden belirttiğimiz sıcaklık 

biriminde  giriyoruz (343 K)>OK  
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Şekil 36 

Sol taraftan verilen havanın sıcaklığını belirlemek için aynı işlemi yapıp sol çizgiyi 

seçiyoruz(291 K) >OK  
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Şekil 37 

 

2.9 Yükleme 

Hava  hızını belirlemek için  

ANSYS Main Menü>Solution>Define loads>Apply >Fluid/CDF>Velocity>on lines 

Dikdörtgenin sol tarafındaki çizgi seçilir ve Vx=6 m/s Vy=Vz=0 yazılır. 
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Şekil 38 
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Şekil 39 

ANSYS Main Menü>Solution>Define loads>Apply >Fluid/CDF>Velocity>on lines 

 

Aynı  işlem silindirik yüzey için uygulanır.    Vx=Vy=Vz=0 değerleri girilir >OK  
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Şekil 40 
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Şekil 41 

Sınır değerleri uygulanmış şekil aşağıdaki gibi olmalıdır. 
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Şekil 42 

 

- Basıncın çevre koşullarında olduğunu belirtmek için  

ANSYS Main Menü>Solution>Define loads>Apply >Fluid/CFD>Pressure DOF >On 

lines 
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Şekil 43 

>OK 
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Şekil 44 

-Referans koşullarını belirtmek için; 

ANSYS Main Menü>Preprocessor>Flotran set up>Flow environment   
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Şekil 45 

Re=6x0.0164/14.82e-6=6639.6 > 4000 

 

Reynold sayısı büyük olduğu için turbülans akıştır. 

  ANSYS Main Menü>Preprocessor>Flotran set up>Turbulence>Turbulence 

model>Standart K-E seçilir>OK   
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Şekil 46 

> OK 
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Şekil 47 

 

2.10 Çözümleme  

koşullarını belirlemek için; 

ANSYS Main Menü>Preprocessor>Flotran set up>Solution options kısmında 

özellikleri aşagıdaki gibi seçiyoruz. 

Steady state 
Thermal 
Turbulence 
İncompressible   
>OK 
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Şekil 48 

>OK 

İterasyon sayısının belirlemek için  ANSYS Main Menü>Preprocessor>Flotran set 

up>Execution ctrl ye tıklıyoruz.EXEC  yazan kısma  300 giriyoruz ve OK   diyoruz. 
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Şekil 49 

ANSYS Main Menü>Solution>Flotran set up>Run FLOTRAN   
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Şekil 50 
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Şekil 51 

2.12 Sonuçlar 

ANSYS Main Menü>General postproc>Read results>First set  diyerek ilk ayarları 

seçiyoruz. 
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Şekil 52 

 

 

ANSYS Main Menü>General postproc>plot results>Contour plot>Nodal solution 

kısmına girerek elde edilen sonuçları okuyoruz. 

 

Aşağıda görüldügü gibi Nodal solution>DOF solution >pressure şeçerek ok diyoruz 

ve çıkan ekran da basınç dağılımını görüyoruz. 
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Şekil 53 
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Şekil 54 Basınçlar 
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Şekil 55 
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                                                           Şekil 56   Akışkanın x yönündeki hızı 
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                                                        Şekil 57 Akışkanın y yönündeki hızı 
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                                                             Şekil 58 Düğüm  sıcaklıkları 
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                                                                  Şekil 59 Toplam akışkan hızı 

Hız profilinin vektörel gösterilmesi 

General Postproc>Plot Results>Vector Plot>Predefined 

>OK 
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Şekil 60 
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3   2 Boyutlu  Laminar Akış Problemi 

 
3.1 Problem tanımı: 373 K sıcaklığa sahip iki  plaka arasından  293K sıcaklığındaki 

ve 0.05 m/s hızdaki  havanın geçirilmesi sonucu akışkandaki  sıcaklık değerlerinin ve 

hız profilinin nasıl geliştiği. 

(SI birim sistemi) > İki plaka arası mesafe 1.5mm plaka uzunluğu 90mm  
 

 

3.2 Utility Menü>File>Change jobname  

 

 
Şekil 61 

 

-Preferences>FLOTAN CFD>OK 

 
3.3 Analizde kullanılacak elementin seçilmesi 

ANSYS Main Menü>Preprocessor>element type>Add/Edit/Delete  

Element types >Add 

 

Library of element types >FLOTRAN CFD>2D FLOTRAN 141>OK 

 
3.4 Akışkan özelliklerinin belirlenmesi 

ANSYS Main Menü>Preprocessor>Flotran set up>Fluid properties   

Density,Viscosity,Conductivity ve Specific heat özelliklerini constant olarak ayarlayın. 
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Şekil 62 

3.5 Sonraki  çıkan pencerede  ortalama sıcaklık için  bulunan  hava değerlerini giriniz. 

Akışkan malzemenin özelliklerinin sıcaklıkla değişmediği varsayılırsa 

 (100+20)/2=60 C için 

D=1.146kg/m^3 , V=1.89e-5Kg/m.s, C=0.027W/m.K, Cp=1000J/Kg.K 

*NOT:Eğer akışkan özellikleri sıcaklık ile değişiyorsa : 

 ANSYS Main Menü>Preprocessor>Material Props>Material Models 

Özellik seçilerek Add Tempurature a basarak çeşitli sıcaklıklardaki özellikleri  yazarak 

belirtebilirsiniz. 
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Şekil 63 

 

3.6 Akış sisteminin modellemesi: 

Dikdörtgensel bir alan oluşturarak sistemi tanımayabiliriz.  

ANSYS Main Menü>Preprocessor>modelling>Create>Areas>Rectangle>By 2 

corners 

X=0 Y=0 Width=0.09m Height=0.0015m girin ve OK  

 

 
Şekil 64 
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Şekil 65 

3.7 ANSYS toolbar >save db 

-Mesh özelliklerini ayarlamak için 

ANSYS Main Menü>Preprocessor>Meshing>Size Cntrls>Manual size>Picked lines 

İlk olarak üst ve alt çizgileri seçiyoruz >Apply 

Çizgileri bölmek istediğimiz eleman sayısını giriyoruz .NDIV= 100 >OK 

Aynı işlemi sağ ve sol çizgiler için tekrarlıyoruz .NDIV=10>OK 

Bölümleme işlemini gerçekleştirmek için ; 

ANSYS Main Menü>Preprocessor>Meshing>Mesh>Areas>Free 

Modeli seçiyoruz >OK 
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Şekil 66 

3.8  Sınır koşulları ve yük uygulamak için; 

Preprocessor>Loads>Define Loads>Apply>Fluid CFD>Velocity>On lines 

Sol taraftaki çizgiyi seçin >OK ve hava hızını girin Vx=0.05 m/s Vy=Vz=0 >OK 

Aynı işlemi üst ve alt çizgiler için uygulayın.Vx=Vy=Vz=0 > OK 
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Şekil 67 

Main Menu>Preprocessor>Loads>Define Loads>Apply>Fluid  CFD>Pressure 

DOF>On Lines sağdaki çizginin ucu açık olduğunu belirtmek için 

Main Menu>Preprocessor>Loads>Define Loads>Apply>Fluid  CFD>Pressure 

DOF>On Lines  

Sağ çizgiyi seçin ve OK diyin.Basınç çevre koşullarında olduğu için basınç kısmına 

hiçbir şey girmeden OK tuşuna basın. 

Sıcaklıkları belirtmek için ; 

Main Menu>Preprocessor>Loads>Define Loads>Apply>Thermal>Temperature>On 

Lines 

Alt ve üst çizgileri seçin >OK> TEMP i seçin ve sıcaklık değerini Kelvin olarak girin 

(373K)>OK 

Yukarıda yapılan işlemi gerçekleştirip> 

Sağ taraftaki çizgiyi setçinizde TEMP i seçin ve yine sıcaklık değerini girin(293K) 
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Şekil 68 

Sınır değerleri uygulandığında son hal aşağıdaki gibi olmalıdır. 

 
Şekil 69 
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3.9 Çözümleme ayarları için ; 

 

Main Menu>Solution>Flotran Set Up>Solution Options  

Açılan pencerede Thermal ve laminar akışı işaretleyin 

 

>OK 

 
Şekil 70 

3.10 İterasyon sayısını belirlemek için ; 

Main Menu>Solution>Flotran Set Up>Execution Ctrl 

EXEC Global iterations   kısmına 300 girin > OK 
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Şekil 71 

3.11 Problemi çözmek için;  

Solution>Run FLOTRAN 

Çözümlemeyi bekleyin…. 

Aşağıdaki ekran belirdiğinde  çözümleme sorunsuz gerçekleşmiş demektir. 
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3.12 Sonuçlar  

 

ANSYS Main Menü>General postproc>Read results>First set  

ANSYS Main Menü>General postproc>plot results>Contour plot>Nodal solution 

 
Şekil  73 Basınçlar 

 
Şekil 74 Toplam akışkan hızı 



15.02.2008 

Ansys-Flotran’a Giriş 68

 
Şekil 75 Sıcaklık dağılımı  

 

General Postproc>Plot Results>Vector Plot>Predefined 

Ayarları  gösterimdeki gibi değiştirin 
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>OK 

Pozisyonlama  menüsünü  kullanarak yakınlaştırarak bakabilirsiniz. 
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Şekil  77 Hız profilinin gelişimi 

 

*Not daha hassas sonuçlar için Mesh özelliklerini değiştirmeniz yeterli olacaktır. 

 


